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Copyright Message
Activity Log is Copyright Swamp Tech, 1995

Swamp Tech is a Trade Mark of Mathew Dredge.





New Activity Log Dialog Box
This dialog box is for entering in information about the project. 
The information needed: 

Project Name: The name of the project that the activity log is for.
Project Owner: The name of the person who the activity log is for.

Click on an object in the dialog picture above for a description.



Export Log Dialog Box
This dialog box is for setting options for the exported log file.

Click on an object in the dialog picture above for a description.

See Importing Activity Log into Word 6 to see how to import the exported file into Word 6.



Activity Stopped Dialog Box
This dialog appears when an activity has been stopped, It shows the start and stop times of 
the activity and the date. The duration of the activity is calculated and shown. If the Cancel 
Button is clicked the activity is not saved. If the Continue Button is clicked the activity will 
continue and anything entered into the Activity Edit is lost.
Enter what was done in the time period into the Activity Edit area.

Click on an object in the dialog picture above for a description.



Enter New Activity Dialog Box
This dialog is for entering activities that have taken place away from the Activity Log 
program, you enter the date, start time, stop time and the activity. The date and times 
entered are subject to validation and various error messages will appear when the Ok Button
is clicked. If a vaidation error has occured then a error message will appear. See Entering 
Valid Dates and Entering Valid Times for information about valid dates / times and examples 
of the error messages. After a validation error message the offending part of the date or 
time will be selected allowing immediate correction.
Note: It is recommended that after entering a number of activities to sort the log, especially 
before exporting.

Click on an object in the dialog picture above for a description.



Activity Log Information Dialog Box
This dialog displays information about the activity log. 

Click on an object in the dialog picture above for a description.



Edit Activity Dialog Box
This dialog is for editing activities you can edit the date, start time, stop time and the 
activity. The date and times entered are subject to validation and various error messages will
appear when the Ok Button is clicked. If a vaidation error has occured then a error message 
will appear. See Entering Valid Dates and Entering Valid Times for information about valid 
dates / times and examples of the error messages. After a validation error message the 
offending part of the date or time will be selected allowing immediate correction.
Note: It is recommended that after entering a number of activities to sort the log, especially 
before exporting.

Click on an object in the dialog picture above for a description.



About Dialog Box
This dialog box shows various irrevalent pieces of information about the program, version 
information e.t.c.



Main Application Window
The main window of Activity Log, is where it all happens. You can initiate all the functions of 
the activity log from here.

When Activity Log Application has just started it would look like this...

When an Activity Log has been opened the caption on the window changes and the window 
will look like this...

When an activity is being logged the button changes its look and the window will look like 
this...

Click on an object in the window pictures above for a description.



Entering Valid Dates
Dates when entered, must be a correct date. The program handles validation of the dates to 
make sure they are of a correct format. Dates are entered in the day/month/year numerical 
format. That means that the date must be entered as 23/07/1995. When entering dates the /
character is automatically entered for you. When the Ok Button is pressed in the dialog, the 
date is validated and if there is a problem you will be notified and the offending part of the 
date is selected ready for reentering. Valid dates must follow some rules, these are:

Date must be entered and include all digits.
Year 1994 to 2000 inclusive.
Month 01 to 12 (Leading 0 must be typed).
Day 01 to Number of days in the month.

The error messages are as follows:

This message is shown when no date has been entered, The cursor will be placed ready to 
enter a date.

These two messages are shown when the date is not completely entered, The entire date 
will be selected allowing editing.



This message is shown when the year is out of range, The year will be selected allowing 
editing.

This message is shown when the month is out of range, The month wll be selected allowing 
editing.

This message is shown when the day is out of range, The day will be selected allowing 
editing.



Entering Valid Times
Times when entered, must be a correct time. The program handles validation of the times to 
make sure they are of a correct format. Times are entered in the hour:minute am format. 
That means that the time must be entered as 10:15 AM. When entering dates the :,      and M
of PM & AM characters are automatically entered for you. When the Ok Button is pressed in 
the dialog, the time is validated and if there is a problem you will be notified and the 
offending part of the time is selected ready for reentering. Valid times must follow some 
rules, these are:

Time must be entered and include all digits.
Last letters AM or PM
Hour 01 to 12 (Leading 0 must be typed).
Minute 00 to 59 inclusive. (Leading 0 must be typed for minutes < 10).
Start Time must be before the Stop Time.

Remember that 12:00 PM is noon midday, and 12:00 AM is midnight.

The error messages are as follows, the auctual program may replace start time with stop 
time :

This message is shown when no time has been entered, The cursor will be placed ready to 
enter a time.

These two messages are shown when the time is not completely entered, The entire time 



will be selected allowing editing.

This message is shown when AM or PM is not entered correctly, The offending letters will be 
selected allowing editing.

This message is shown when the hour is out of range, The hour wll be selected allowing 
editing.

This message is shown when the minute is out of range, The minute will be selected allowing
editing.

This message is shown when the start time is after the stop time, The start time will be 
selected allowing editing.



Main Window Menus
These are the menus from the main window, some of the items may be disabled at various 
points in time. Click on a item in the menu for an description:

File Menu

Log Menu

View Menu

Help Menu



List / Edit Window
This window is acessable using the View-> List / Edit menu option from the main window or 
py using the CTRL+L key combination. This view lets you preview the Activity Log and edit, 
add, delete activities. After a change is made to the log, the log file is saved. This is for 
compatability with how the main window handles the files. The Main Window can be used 
when this window is open. The Activity description text is contatanated to the first 50 
characters or the first line, if the text is concatanated it will be followed by three periods.

Click on a part of the window picture above for a description.



List / Edit Window Menus
These are the menus from the list / edit window, some of the items may be disabled at 
various points in time. Click on a item in the menu for an description:

File
Close

Edit

Options

Help



Creating New Activity Logs
There is 3 steps to creating an Activity Log:

1) Select File-New from the Main Window Menu. (Remember to close the List / Edit 
Window if it is open).

2) Enter Project Name and the Project Owner into the New Activity Log Dialog Box and 
then click the Ok Button.

3) Enter a filename into the File Open Dialog Box, Activity Logs have the extension of 
ALG, it is not required to enter this. Then click the Ok Button.

The Activity Log is now created, see Creating Activities for information about creating 
activities.



Creating Activities
If you have not yet created an Activity Log, see Creating New Activitiy Logs.

There is 3 steps to creating an activity.

1) Click the Start Activity Button, Press ENTER or select Log->Start Activity from the 
Main Window Menu when you are to start doing something.

2) Click the Stop Activity Button, Press ENTER or select Log->Stop Activity from the Main
Window Menu when you have finished what you were doing. The Stop Activity Dialog 
Box appears.

3) Enter what you did into the activity edit. Then click the Ok Button.

If you have accidentally stopped the activity, you can continue the activity by clicking the 
Continue button.

If you do not want the activity to be logged for any reason, stop the activity and click the 
Cancel Button.

Activies can be entered from scratch using one of the Enter New Activity menu options, this 
will show the Enter New Activity Dialog Box where you can enter the details about the 
activity.

See Special Features for more information about how activities are handled.



Special Features
There are a number of features in the Activity Log Program, these are:

When the program is started, the last activity log is re-opened, if no activity log was 
open when the program was quit, then no log is loaded.

When a Activity Log is closed, or the program is quit and an activity was being 
logged, then when that file is re-opened or the program is re-started that activity is 
continued. This allows you to turn the computer off / quit to dos e.t.c to work and when you 
come back you can continue the activity.
Note: An activity cannot span days, if this has happened, the activity is stopped at 11:59 PM 
of the day it was started. 

If the List / Edit Window is open and an activity was stopped or entered using the 
Main Mindow, the list will update automatically.



Importing Activity Log into Word 6
This is the method I use for printing an Activity Log using Word 6.

1) Export the Activity Log, using % for the Field Delimiter and # for the Record 
Delimiter.

2) Load Word 6 and place cursor in document where I want the log to go.

3) Select Insert->Database from the menu.

4) In the Database Dialog Box, click the Get Data button.

5) Select the exported log file in the Open Data Source Dialog Box.

6) In the Header Record Delimiters Dialog Box, select % as the Field Delimiter and # as 
the Record Delimiter and click OK.

7) In the Database Dialog Box click the Table Autoformat Button.

8) In the Table Autoformat Dialog Box, select simple3 from the format list.

9) Click off the First Column check Box, under the Apply Special Formats to Group, then 
click OK.

10) In the Database Dialog Box, click the Insert Data Button.

11) In the Insert Data Dialog, click the OK Button..

12) Done..

The result of the above 12 steps will look like this:





Ok Button
Clicking on the Ok Button accepts what was entered into the dialog box, or clears the dialog 
box if the dialog is only showing information.



Cancel Button
Clicking on the Cancel Button clears the dialog without accepting the data that was entered.



Help Button
Clicking in the Help Button shows the help for the dialog.



Activity Number
The number represents an index of the activity that is being entered / edited.



Date
The Date is the date that the activity has taken place.



Start Time
The Start Time is the time that the activity was started.



Stop Time
The Stop Time is the time that the activity was stopped.



Duration
The Duration is how long the activity has taken, the duration is in hours and minutes.



Continue Button
The Continue Button allows you to continue the activity if it was accidentally stopped.



Activity Edit
The Activity Edit allows you to enter in what was done for the activity period. You can enter 
multiple lines and long lines will word-wrap.



Edit Selected Activity
The Edit Selected Activity menu item brings up the Edit Activity Dialog Box, for the activity 
that was selected in the list. Pressing the Enter key does the same as using the menu item.



Add New Activity
The Add New Activity menu item brings up the Enter New Activity Dialog Box, You can enter 
details of an activity that was done without the use of this program. Pressing the Insert key 
does the same as using the menu item.



Delete Selection
The Delete Selection menu item deletes the activity that was selected in the list. 
Confirmation may be asked for if the Delete Confirm menu item in the Options menu is 
checked.



Date
The date the activity was done on can be entered or edited here. See Date Validation for 
information about how to enter a valid date and what any error messages might mean.



Activity Started
The time the activity started can be entered or edited here. See Time Validation for 
information about how to enter a valid time and what any error messages might mean.



Activity Stopped
The time that the activity stopped can be entered or edited here. See Time Validation for 
information about how to enter a valid time and what any error messages might mean.



New
The New menu option creates new Activity Logs, see Creating Activity Logs for more 
information.
Note: This option is disabled if the List / Edit window is open or an activity is being logged.



Open
The Open menu option opens existing activity log files, if an activity log is open it will be 
closed.
Note: This option is disabled if the List / Edit window is open or an activity is being logged.



Save As
The Save As menu option saves the currently loaded activity log in a new location and under
a different file name.
Note: This option is disabled if the List / Edit window is open or an activity is being logged.



Close
The Close menu option closes the current activity log, if an activity is currently being logged 
the activity will be resumed the next time the activity log is opened.
Note: This option is disabled if the List / Edit window is open.



Export
The Export menu option exports the current activity log to a file that can be imported into a 
word processor or database. The Export dialog box is displayed. See Exporting Activity Logs 
for more information.
Note: This option is disabled if the List / Edit window is open or an activity is being logged.



Exit
The Exit menu option exits the program. If there is a activity log open then it is closed and if 
there is an activity being logged then it will resume when the file is reopened. When the 
program is restarted the last activity log will be reopened.



Contents
The Contents menu option loads the help Contents page.



How Tos
The How Tos option loads the help How Tos Index page.



Windows
The Windows option loads the help Windows Index page.



Dialog Boxes
The Dialog Boxes option loads the help Dialog Boxes Index page.



Menus
The Menus option loads the help Menus Index page.



About
The About menu option shows the About Dialog Box for a bit more irreverent information.



Field Delimiter
Select one of the radio buttons in this group to select what character fields will be deimited 
(separated) with, you should use a character that has not been entered into the activity log. 
For more information see Exporting Activity Logs and Comma, Tab, Return, Other.



Comma ,
Selecting this radio box uses the comer character to delimit (separate) the fields when they 
are exported.



Tab
Selecting this radio box uses the tab character to delimit (separate) the fields when they are 
exported.



Return
Selecting this radio box uses the return character to delimit (separate) the fields when they 
are exported.



Other
Selecting this radio box uses the character that is entered into the edit next to it to delimit 
(separate) the fields when they are exported. The edit will only be enabled when the Other 
radio is selected.



Record Delimiter
Select one of the radio buttons in this group to select what character records will be 
deimited (separated) with, you should use a character that has not been entered into the 
activity log. For more information see Exporting Activity Logs and CommaC, Tab, Return, 
Other.



Comma ,
Selecting this radio box uses the comma character to delimit (separate) the records when 
they are exported.



Tab
Selecting this radio box uses the tab character to delimit (separate) the records when they 
are exported.



Return
Selecting this radio box uses the return character to delimit (separate) the records when 
they are exported.



Other
Selecting this radio box uses the character that is entered into the edit next to it to delimit 
(separate) the records when they are exported. The edit will only be enabled when the Other
radio is selected.



Other Options
The Other Options group contains check boxes for turning on and off options for the export. 
For more information see Exporting Activity Logs and Field Headers, Remove Returns from 
Activity, Include Duration, Include Total Duration.



Field Headers
Selecting Field Headers will write the headers for each field as the first record exported to 
the file.



Remove Returns from Activity
Selecting Remove Returns from Activity will remove all returns (line breaks) from the activity
fields, the returns will be replaced with a semi colon and a space ; .



Include Duration
Selecting Include Duration will export the duration field for each activity.



Include Total Duration
Selecting Include Total Duration will export the total duration of the project as the last 
record.



Start Activity
The Start Activity menu option will start a new activity, the Enter key or clicking the Start 
Activity will do the same as this menu option.



Stop Activity
The Stop Activity menu option will stop the current activity and bring up the Activity Stopped
Dialog Box, the Enter key or clicking the Stop Activity will do the same as this menu option.



Enter New
The Enter New menu option brings up the Enter New Activity Dialog Box, You can enter 
details of an activity that was done without the use of this program. Pressing the Insert key 
does the same as using the menu item.



Sort
The Sort menu option sorts the activity log in the order of date then start time. Use this 
option if activities have been entered using the Enter New menu item, and you want to 
export the log.



Main Windows Caption
The caption will show Activity Log if there is no activity log opened, otherwise the name of 
the project will be displayed.



Main Window Menu
See Main Window Menus.



Start Activity Button
Click the Start Activity button to start a new activity, the Enter key or the Start Activity menu
item will do the same as clicking the button.



Stop Activity Button
Click the Stop Activity button to stop the current activity and bring up the Activity Stopped 
Dialog Box, the Enter key or the Stop Activity menu item will do the same as clicking the 
button.



Project Name
Enter the name of the project that the activity log is for in this edit.



Project Owner
Enter the name of the person who is keeping the activity log in this edit.



List / Edit
The List / Edit menu item displays a list window that can be used to view and edit the 
activity log. See List / Edit Window for more information, pressing CTRL+L is the same as 
using this menu option.



Information
The Information menu item displays the Activity Log Information Dialog Box.



Show Duration
Checking the Show Duration menu item shows the durations of the activities in the List / Edit
Window.



Show Headers
Checking the Show Headers menu item shows the field headers in the window.



Delete Confirm
Checking the Delete Confirm menu item sets confirmation when activities are deleted.



Project Name
This is the name of the project that the activity log is being kept for.



Log Owner
This is the name of the person who is keeping the activity log.



First Log Entry Date
This is the date of the first activity in the log.



First Log Entry Time
This is the start time of the first activity in the log.



Last Log Entry Date
This is the date of the last entry in the activity log.



Last Log Entry Time
This is the stop time of the last entry in the activity log.



Total Time
This is the total time (duration) the activity has taken.



List / Edit Window Caption
This caption shows the Project Name of the activity log.



List / Edit Window Menu
See List / Edit Window Menus



List / Edit Window Headers
This is the field headers for the list, this can be turned on and off using the Show Headers 
menu item.



Date Field
This shows the date of the activities.



Start Field
This shows the start time of the activities.



Stop Field
This shows the stop time of the activities.



Duration Field
This shows the duration of the activities, this can be turned on and off using the Show 
Duration menu item.



Activity Field
This shows part of the activity text for the activities. The first fifty characters of the first line 
is shown, or only the first line. If the activity is truncated three periods are shown (...).






